Table of contents

1 Introduction ................................................. 1-1
   Introducing your new Xerox 4112/4127 .......................... 1-1
   System components ............................................. 1-1
   The User Interface (UI) ......................................... 1-2
Powering on and off ............................................. 1-3
   Power on ......................................................... 1-3
   Power off ....................................................... 1-3

2 Using basic features ........................................... 2-1
   Print the Quick Reference for Administrators document ........... 2-1
   Exercise 1: Loading paper ....................................... 2-2
     Loading paper into Tray 1 ...................................... 2-2
     Loading Paper into Tray 3 ...................................... 2-3
   Exercise 2: How to copy from the document glass .................. 2-5
   Exercise 3: How to copy from the document feeder ................. 2-7
   Exercise 4: How to check the status of your job ................... 2-9
   Exercise 5: How to check the machine status ...................... 2-11
   Exercise 6: How to call for service .............................. 2-14

3 Computer Operations ........................................... 3-1
   Network Printing ................................................ 3-1
     Printing with the PS print drivers .............................. 3-1
     Printing with the PCL print drivers ............................ 3-2
   CentreWare Internet Services .................................... 3-5
     Print a job from CentreWare Internet Services .................. 3-5

4 Quick Reference for Users ...................................... 4-1
   Getting Help .................................................... 4-1
   Features on the All Services screen ............................. 4-2
   User Interface components ...................................... 4-3
Introduction

Introducing your new Xerox 4112/4127

The Xerox 4112/4127 is a black and white copier/printer or copier only. The 4112 prints at 110 pages per minute. The 4127 prints at 125 pages per minute.

System components

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Duplex Automatic Document Feeder (DADF)</td>
<td>Automatically feeds 1 and 2-sided original documents to the Document Glass.</td>
</tr>
<tr>
<td>2</td>
<td>Power Switch</td>
<td>Switches on/off the machine power.</td>
</tr>
<tr>
<td>3</td>
<td>User Interface (UI)</td>
<td>Control Panel and Touch Screen used to enter and view information.</td>
</tr>
<tr>
<td>4</td>
<td>Trays 1, 2, 3, and 4</td>
<td>Holds the paper that is used to copy and print.</td>
</tr>
<tr>
<td>5</td>
<td>Bypass Tray (Tray 5)</td>
<td>Load nonstandard paper, such as heavy stock or other special media, that cannot be loaded in trays 1-4.</td>
</tr>
</tbody>
</table>

For more detailed information, refer to the User Guide and the System Administration Guide, which were supplied with your Xerox 4112/4127.
# The User Interface (UI)

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Services</td>
<td>Displays the job features on the touch screen.</td>
</tr>
<tr>
<td>2</td>
<td>Control Panel</td>
<td>Select features with buttons and the keypad.</td>
</tr>
<tr>
<td>3</td>
<td>Touch Screen</td>
<td>Select the available programming by touching the screen.</td>
</tr>
<tr>
<td>4</td>
<td>Job Status</td>
<td>Displays the Job Status feature screens.</td>
</tr>
<tr>
<td>5</td>
<td>Machine Status</td>
<td>Displays the current status of the machine on the touch screen.</td>
</tr>
<tr>
<td>6</td>
<td>Energy Saver</td>
<td>This button lights when the machine is in the Power Saver mode. Press this button to exit Power Saver mode.</td>
</tr>
<tr>
<td>7</td>
<td>Clear All</td>
<td>Clears all programming and returns the machine to its default settings.</td>
</tr>
<tr>
<td>8</td>
<td>Interrupt</td>
<td>Temporarily stops the current copy job to allow a priority job to be run.</td>
</tr>
</tbody>
</table>

![Diagram of the User Interface](image)
Powering on and off

Switch on the power before operating the machine. The machine warms up in approximately five minutes, after which you can make copies. Switch off the machine at the end of the day or when it is not in use for a long period of time.

Power on

To power on the machine:

1. Open the cover.
2. Press the power switch to the on position [I].

Note
The "Please wait..." message on the UI indicates that the machine is warming up. The machine cannot be used while it is warming up.

Power off

1. Wait until all copy and print jobs have completely finished.
2. Press the power switch to the off position [ ].
You will now use some of the basic features of your new Xerox 4112/4127. As you perform the exercises in this section, you will learn how to:

- Load paper in paper trays 1 and 3
- Copy documents with basic copy features
- Check job status
- Check machine status
- Call for service

Print the Quick Reference for Administrators document

Before you begin the exercises:
1. Locate the customer documentation CD that came with your Xerox 4112/4127.
2. Print the Quick Reference for Administrators document from the customer CD. Print it as a one-sided letter or A4 size document on any printer.
3. After printing the document, take it to the Xerox 4112/4127. You can use it practice making copies during exercises 2 and 3.

Note
Leave the document at the Xerox 4112/4127 for quick reference of System Administrator functions.
Exercise 1: Loading paper

For this exercise, you will load **8.5 X 11 in.** or **A4** paper in tray 1 and load **11 X 17 in.** or **A3** paper in tray 3.

Loading paper into Tray 1

1. Slowly pull out the tray towards you until it stops.

![WARNING]
If you pull the tray out using too much force, it can hit and injure your knees.

2. Load **8.5 x 11 in.** or **A4** paper and align the edge of the paper against the left edge of the tray.
Note
Do not load paper exceeding the maximum fill line.

3. Push the tray in gently until it comes to a stop.

Loading Paper into Tray 3

1. Slowly pull out the tray towards you until it stops.

WARNING
If you pull the tray out using too much force, it can hit and injure your knees.

2. Load 11 x 17 in. or A3 paper and align the edge of the paper against the left edge of the tray.
Note
Do not load paper exceeding the maximum fill line.

3. Squeeze the paper guide levers (2) and adjust the guides to match the size of your paper.

4. Push the tray in gently until it comes to a stop.
Exercise 2: How to copy from the document glass

1. Open the document feeder.

2. Place the document face down on the document glass.

3. Close the document feeder.

4. Press the Services button.
5. Select the **Copy** tab, which displays the standard features of a copy job. Select a **More...** button to see additional options for the feature.

6. Enter the copy quantity.

7. Press **Start**.
Exercise 3: How to copy from the document feeder

1. Place a multiple page document, face up, in the document feeder.
2. Adjust the document guides so they just touch the edges of the paper.
3. The indicator lights to show that the document is loaded correctly.

4. Press the **Services** button.

5. On the **Copy** screen, select **Paper Tray 1**, which is loaded with 8.5 x 11 in. or A4 paper.
6. On the same screen, select a **2-Sided Copying** option.
   - Select 1-2 Sided if your originals are 1-sided.
   - Select 2-2 Sided if your originals are 2-sided.
7. Select the **Copy Output** button.

8. If applicable, select a **Staple** option.

9. If applicable, select a **Hole Punch** option.

10. Select **Save**.

11. Enter the copy quantity **2**.
12. Press **Start**.

13. Check the output for the options you selected (2-Sided, stapled, punched).

**Exercise 4: How to check the status of your job**

1. Press **Job Status** on the Control Panel.

2. Select the **Active Jobs** tab, which displays jobs that are printing or waiting to print.

3. If there is a job on the Active Jobs tab, touch the job on the touch screen.

Notice that a pop-up menu allows you to delete the job, promote it, or display job details.
4. Select the **Completed Jobs** tab, which displays all completed jobs.

5. Open the **View** menu, which is used to filter the list.

6. Select **All Jobs**.

7. Locate the copy jobs that you completed and touch one of them to display a report.

8. Select **Print This Job Report** to print a hard copy.

9. Select **Close**.
Exercise 5: How to check the machine status

1. Press the **Machine Status** button.

2. Read the following tab descriptions.
   - The **Machine Information** tab displays the serial number, current system software version, and IP address. Buttons provide access to other information, including the Machine Configuration, Software Versions, and Paper Tray Status.
• The **Faults** tab provides access to information about faults and machine messages.
  - Select Current Faults and Instruction to get instructions for clearing a fault.
  - Select Current Messages to view actions that are needed to keep the copier/printer operating properly.
  - Select Fault History to see a list of fault codes.

![Faults tab](image)

• The **Supplies** tab provides status information about the supplies that are used in the copier/printer. The remaining toner is shown on a gauge. The status of other supplies is shown as OK, Replace Soon, or Replace Now.

![Supplies tab](image)
• The **Billing Information** tab displays the serial number of the copier/printer, the names of counters, and current counts. Select **Usage Counters** to view individual counters.

![Billing Information Tab](image)

• The **Tools** tab provides access to setup features. Regular users have limited access to basic features. System Administrators have access to a full set of features.

![Tools Tab](image)
Exercise 6: How to call for service

Refer to the User Interface when you have a problem with the copier/printer. A status code and suggested solutions may be displayed on the screen. Follow all steps in the suggested solutions until the problem is corrected. If the problem persists, call for assistance.

Before calling Xerox for assistance, gather the following information:
1. A complete description of the problem.
   If copy quality is a problem, have a sample available to help you describe the defect.
2. Any Fault Codes that are displayed on the User Interface.
3. The machine serial number.
   Press Machine Status and locate the serial number on the Machine Information tab.

In the US, call 1-800-275-9376 extension 871.

In Canada, call 1-800-939-3769.

In Europe, go to www.xerox.com and select the Contact Us link to locate a telephone number for your country.

Note
If possible, call from a telephone that is near the copier/printer.
Note
The screens shown in this section may or may not reflect your print driver screens. The screens may vary depending on your drivers configuration and marketplace. The screens shown here are a representation only.

Network Printing

Print procedures vary depending on the application software you are using. For more information, refer to the documentation provided with each application.

To learn about print features, click Help in the print driver screen and refer to the online help.

Printing with the PS print drivers

1. Load the paper in the paper tray. See the Paper and other Media chapter in the User Guide.
2. From your computer, open the document you want to print.
4. Select the desired printer.
5. Select Properties.
7. Select the appropriate **Paper Tray**, **Paper Size**, and **Paper Type**.

![Xerox 4127 Properties](image)

8. Select the **Advanced** tab and select any **Advanced Features**.
9. Select **OK** to save and close the **Properties** window.
10. Select the desired copies/quantity and **OK** to print the job.

   **Note**
   
   For additional information, review your print driver documentation.

**Printing with the PCL print drivers**

1. Load the paper in the tray. See the **Paper and other Media** chapter in the User Guide.
2. From your computer, open the document you want to print.
3. Select **File > Print**.
4. Select the desired printer.
5. Ensure that **Auto-Rotate and Center** and **Choose Paper Source by PDF page size** are unchecked.

6. Select **Properties** and select the **Paper/Output** tab.

---

**Note**

These options may not be available with your version of Adobe Acrobat or Adobe Reader.
7. Click the **Paper Select** button.

8. If Tray 3 or Tray 4 is being used, then select **Paper Settings for Auto Tray** and choose the appropriate paper type.

9. Select **OK** twice to return to the Properties screen.

10. Select the **Advanced** tab and select any **Advanced Features**.

11. Select **OK** to save and close the **Properties** window.

12. Select the desired copies/quantity and **OK** to print the job.

**Note**

For additional information, review your print driver documentation.
CentreWare Internet Services

CentreWare Internet Services requires a TCP/IP environment, and enables you to view the status of the machine and its jobs, as well as submit jobs for printing.

Print a job from CentreWare Internet Services

Note

Only print ready files (*.ps, *.pcl, *.jpeg, *.tiff, *.pdf, etc.) may be submitted to the device from the CentreWare Internet Services web page.

1. Start your computer and open the browser.
2. Enter the device IP address or Internet address in the browser address field and press the Enter key on your computer’s keyboard.

Note

If you cannot access your machine via CentreWare Internet Services, see your System Administrator for help.
3. From the CentreWare Internet Services screen, select the **Print** tab.

4. Select a file to print by clicking the **Browse** button and navigating to the desired file.

5. Select your desired print options.

6. Select the **Submit Job** button to print the job.
Quick Reference for Users

Getting Help

For information/assistance, check the following:

- User Guide for information on how to use the Xerox 4112/4127.
- For online assistance go to: www.xerox.com
  - Click the Support and Drivers link.
  - In Product Name, type 4112/4127 and click Search.
  - From the list presented, locate your model (4112 or 4127).
  - Click the appropriate link for the desired information: Support, Drivers & Download, or Documentation
- You may also call for technical assistance.
  - In the US, call 1-800-275-9376 extension 871.
  - In Canada, call 1-800-939-3769.
  - In Europe, go to www.xerox.com and select the Contact Us link to locate a telephone number for your country.
### Features on the All Services screen

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy provides access to the Copy screen for programming copy jobs.</td>
<td><img src="image" alt="Scan to PC" /></td>
<td>Scan to PC creates electronic files from hard copy originals and sends them to your PC or other external storage.</td>
</tr>
<tr>
<td><img src="image" alt="E-mail" /></td>
<td>E-mail allows documents to be scanned and e-mailed.</td>
<td><img src="image" alt="Send from Mailbox" /></td>
<td>Send from Mailbox allows you to print, e-mail, or fax documents from your mailbox.</td>
</tr>
<tr>
<td><img src="image" alt="Scan to Mailbox" /></td>
<td>Scan to Mailbox creates electronic files and stores them in mailboxes on the 4112/4127.</td>
<td><img src="image" alt="Stored Programming" /></td>
<td>Stored Programming saves and stores multiple job steps as a single job.</td>
</tr>
<tr>
<td><img src="image" alt="Network Scanning" /></td>
<td>Network Scanning creates an electronic file from a hard copy original.</td>
<td><img src="image" alt="Job Flow Sheets" /></td>
<td>Job Flow Sheets allows you to use more than one service with a single template.</td>
</tr>
</tbody>
</table>
## User Interface components

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Panel</td>
<td>Allows keypad selection of features.</td>
<td>Stop</td>
<td>Press to stop the current copy job or communication.</td>
</tr>
<tr>
<td>Touch Screen</td>
<td>Allows selections by touching the screen.</td>
<td>Start</td>
<td>Press this button to start the copy process.</td>
</tr>
<tr>
<td>Services</td>
<td>Press this button to access the services screens, such as Copy, Scan to</td>
<td>Numeric Keypad</td>
<td>Press these buttons to enter numeric values, such as the number of copies.</td>
</tr>
<tr>
<td></td>
<td>Mailbox, etc.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job Status</td>
<td>Press to view Job Status feature screens, to confirm or cancel jobs, or</td>
<td>Clear</td>
<td>Press this keypad button to clear a numeric value or if instructed to do</td>
</tr>
<tr>
<td></td>
<td>to confirm or print saved documents.</td>
<td></td>
<td>so on the User Interface.</td>
</tr>
<tr>
<td>Machine Status</td>
<td>Select Machine Status features such as billing and consumables information.</td>
<td>Language</td>
<td>Use this button to select the display language.</td>
</tr>
<tr>
<td>Energy Saver</td>
<td>Lights when in Power Saver mode. Press to cancel Power Saver mode.</td>
<td>Log In/Out</td>
<td>This button is used to log into modes used by the System Administrator.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Clears all programming and returns to all default settings.</td>
<td>Brightness dial</td>
<td>Use to adjust the brightness of the touch screen.</td>
</tr>
<tr>
<td>Interrupt</td>
<td>Press to interrupt copying or printing to promote a higher priority job.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>